
Notes For Making an NTI Toolkit 
1.29.2007 revised 

 

 

General Style Notes 

 

NTI terms Use acronym NTI; not NTICCHC, and do not include “the” before 

NTI 

 

Refer to graduates and those in training as NTI Trainers (Trainers 

is always capitalized in this instance and NTI should always 

precede it when referring to NTI graduates. When referring to 

trainers in the abstract, no need to capitalize.) Do not refer to 

CCHC trainers unless specifically referencing trainers who have 

not graduated from NTI. 

 

Use “child care facilities” or “child care” to describe all locations 

where children are cared for by someone other than their own 

parents/caregivers. Use other terms only when needed: e.g., 

“Describe the disease prevention benefits of out-of-home child 

care” or “high quality out-of-home child care.”  

 

Unless a header, do not capitalize child care health consultant. 

 

Margins Page margins should be set at 1” all around. 

 

Hyphenation Certain words should always be hyphenated.  Examples: 

-Out-of-home 

-Train-the-trainer 

-Three-year-old (all ages) 

 

Bulleted lists Please use the bullet tool for all lists, including checkboxes.  

 

Bullets (round bullet mark) should be set at .1” and text indented 

at .3”. Sub-bullets (dash or numbers) should be set at .3” and text 

indented at .5”. 

 

The first word in a bulleted list should be capitalized. 

 

When possible, use the same style of wording for all items in a list 

(i.e., parallel phrasing) (e.g., if one or more items begins with an 

action verb then all items in the list should be revised to start with 

an action verb). 

 

Unless the items in a list are complete sentences, no punctuation 

should be used at the end of each item. 



 

Key phrases or topics may be bolded to highlight them, for 

example: 

 The three key elements are: 

- Accessibility: The care should be available in the 

community 

- Continuity: The care should be available from infancy 

through adulthood 

- Compassion: The care should be provided with the well-

being of the family as top-priority 

 

Do not use a bullet if there is only one item in a list/section. 

 

Numbered lists All numbered lists should use the automatic numbering feature 

found in MS Word.   

 

Numbered lists should be used to denote a list of steps, directions 

or procedures (i.e., when order or sequence is important)  

 

Spaces There should be only one space after periods (between sentences); 

not two. 

 

Use spaces (hard returns) between paragraphs. Do not indent the 

first word of each paragraph. 

 

Referring to other NTI 

materials 

When another toolkit component or module is referenced, the 

component or module’s complete title (or name) should be used 

and italicized. 

 

The type of document, i.e., Toolkit, Trainer’s Guide, Training 

Module, etc. should always be capitalized. These words should not 

be italicized. Please note that participant’s packet should not be 

capitalized (unless in a heading) because it is not an official NTI 

document. 

 

Example 1: See NTI’s Building Curriculum Development and 

Training Skills Training Module for ideas about introductions and 

icebreaker activities. 

Example 2: Please see page 25 of this Trainer’s Guide for the 

activity. 

 

References to sections of documents should be in quotation marks, 

such as: For more information, please see Module section, “What 

the CCHC Should Know: Cultural Competency.” Activities should 

also be in quotation marks when referred to in the document.  

 



Saving documents File name should consist of the abbreviated module title plus the 

reviewer’s initials and date of review. Example: The file name for 

Tobie’s edits to the Building Consultation Skills Module would be: 

consultmodule[tb]01_17_06.doc. 

 

 

 

Trainer’s Guide Formatting Notes 

 

The template The template, “Toolkit Template 3_29_07.doc” can be used as the 

foundation for your new toolkit. Open this document and resave it 

with a new file name (so that you can save changes without saving 

over the template).  

 

Using the built-in styles In order to access the styles for the Trainer’s Guide, open the 

template and select the “Format” menu from the top of the page, 

then select “Styles and Formatting.” 

 

In most Word programs, the list of available styles will open at the 

right-hand side of your screen, although some version of Word 

have a drop-down menu that appears in the toolbars at the top of 

the screen. 

 

You should only see the styles that I have created for the template. 

These include: Title, Header, footer, Heading 1 and 2, Normal, 

Body text Bold, Body text Italics, footnote text, copyright text, and 

some bullets. 

 

If you see more than this, you might be able to customize what 

appears in your list by changing which styles are shown. If you 

select “Formatting in use” you should see only the styles used in 

the template. Some of the styles are only used in the last couple of 

pages (such as “36 pt, Centered” and various 10pt text styles). If 

you want to hide these, you can create a custom list of which 

styles are shown. 

 

Please try to format your document by selecting the appropriate 

style rather than by highlighting text and using all of the 

formatting options in the toolbars. This will help to keep the 

document clean and free from bugs/formatting glitches. 

 

If you do have to create your formatting, that’s fine, but make an 

effort to use what’s already there. 

 

Please note that Heading 1 and 2 are the same. Heading 1 should 

only be used for items that you want to appear in the table of 



contents. Heading 2 should be used for all other sub-heads, etc. 

 

If you are copying and pasting text from another document into 

the template, please paste it unformatted and then format 

according to the styles. To paste unformatted text, go to the “Edit” 

menu and select “Paste Special” and then “Unformatted text.”  

 

Version number All Toolkits start at version 1, regardless of the version number of 

the module they are based on. 

 

Page numbering Copyright and “Notes to Trainer” page numbers should be small 

roman numerals: I, ii; numbered pages start at “Table of 

Contents”. 

 

All pages have a page number except for the final page (the 

Participant’s Packet Cover Page). 

 

Header and footer The Header should contain the name of the document, the version 

number, and the date created or revised.  

Example: Cultural Competency and Communication Skills 

Trainer’s Guide version 1, 1/20/2007 

 

The Header should be italicized and should not exceed one line. 

 

Make sure to check that the Header has been updated throughout 

the document. If there are section breaks, it may need to be 

updated in a couple of spots. 

 

The Footer  contains the NTI copyright: © The National Training 

Institute for Child Care Health Consultants, UNC-CH, 2007 and 

the page number. The page number should be aligned to the right. 

 

See the template for font size and styles. 

 

Copyright page Update the title, date updated,  and suggested citation.  

 

Note to Trainer This section should be used to explain the Toolkit (briefly) and its 

relationship to other NTI Modules or Toolkits.  

 

Table of Contents Please use the automated table of contents function (found under 

the Insert menu  Reference  Index and Tables); please let me 

know if you need help with setting this up. 

 

The table of contents should only list Heading 1 items (see 

template and prototype for examples). 

 



Preparation Checklist Update the titles of Modules and other materials referenced here. 

 

In the “Preparation” section of the Preparation Checklist, instruct 

trainers to copy any module appendixes that are relevant as 

handouts for the participants. 

 

List all equipment and supplies needed for the activities (including 

supplemental activities). Make sure to list which activity the 

materials listed are for. 

 

Remember to use the bullet tool. The box bullet and indented box 

bullet have been set up in the “Styles and Formatting” menu 

(found under “Format”) in Word. 

 

Overview of Training 

Session 

Update with specific times, topics, and methods. 

 

You may want to add time for a review section, before the closing 

presentation.  

 

If the “Learning Assessment” is a test, add time at the beginning 

for taking a pre-test version as well. 

 

Trainer’s Outline Fill in the template as needed. Use the “Table” menu in Word to 

add or delete cells as needed. 

 

Remember, only use the bullet (available in the “Styles and 

Formatting” menu) if there is more than one item in a section. 

 

Add a hard return at the end of each section, except for “Time” 

and “Method.” 

 

Place the slide images in the “Talking Points” section, to the right 

of the text (see below for further instructions). 

 

Cells from the tables should not bleed from one page to the next. 

Insert a page break (“Insert” menuBreakPage break). 

 

Each new topic in the training should start on a new page (the 

Assessment and Evaluation sections are an exception, since those 

are so short). 

 

See the template and prototype for models of this section. 

 

Materials for 

Participant’s Packet 

This page lists all the remaining materials in the document. Update 

the activities section to include any activities included in the 

training. 



Activities These are for the trainers to print and include in participant’s 

packets, so the activities should include any instructions, 

worksheets, etc. that are needed. 

 

List possible discussion points and answers in the Trainer’s 

Outline. You might also want to include a completed sample 

worksheet in the Trainer’s Outline (see the p. 21 of the prototype 

for an example). 

 

Include the “required” activities first, followed by any 

supplemental activities. 

 

Evaluation of Trainer This form should not be edited. 

 

Cover Page Update this page with the title of the training session. 

 

 

 

PowerPoint Formatting Notes 

 

Sally John’s template Please use the Sally John’s template for all slide presentations.  

 

All text should be in the central, dark area of the slide and should 

be formatted so that it doesn’t bleed onto the areas of other colors. 

 

Text size should be large enough to be clearly legible, but may 

vary from slide to slide depending on the content. Approx. 44pt. in 

the title and 36 pt. in the body of the slide is a good starting 

point—adjust as needed. 

 

All text should be white (use underline and bold for emphasis 

rather than another color of text). 

 

Make sure the page number is in black text—otherwise it is not 

visible. 

 

Photos and images can be placed outside of the dark area, if 

needed. 

 

Please make sure any photos or images are directly related to the 

text. 

 

Inserting the slide 

images into a Word 

document 

1. Finalize the slides in PowerPoint using the new 

template.  

2. In the PowerPoint program select the File 

menuSend toMicrosoft Office Word. 



3. You will be prompted to select a layout, such as 

with notes or blank lines; any of these will work 

except for “Outline only.” If you want to copy and 

paste the notes from an existing PPt. into the 

Trainer’s guide, use of the notes options to transfer 

any notes as well. Also make sure to select the 

“Paste” option, not “Paste link.”  

4. A new Word document should open, with images of 

all your slides. Save this document (you won’t need 

to save this permanently, but you may want a saved 

copy on case of any crashes, or so you can have the 

slide images available over time.) 

5. When you are ready to put the slide images into 

your Trainer’s Guide, open both the Word document 

with the slides that you just sent from PowerPoint 

and the Trainer’s Guide document. You will be 

switching back and forth between these. 

6. Right click on the slide image that you want, and 

select either “Copy” or “Cut” (Ctrl-C or Ctrl-X). 

7. Now, go to the place in the Trainer’s Guide and 

place your cursor where you want to paste the slide 

and select “Paste” from the edit menu (or use the 

Ctrl-V shortcut). 

8. Right click on the image and select “Format object.” 

Select the “square” layout option and under 

"Horizontal alignment" select the "other" option. 

The size should be 45% of the original (this was the 

automatic size after sending the images to Word; 

you probably won’t have to change it).  

9. Right click on the newly pasted image and select 

“Borders and Shading” from the menu that appears. 

Please click on the “none” option and click “Okay.” 

10. That’s it!  You may need to readjust your talking 

points text a bit to fit nicely around the slide. Also, 

if you are scrolling back and forth through the 

pages, you may notice that the slide images don’t 

always appear, but they are there—it just takes 

Word a while to process images.  

11. Other instructions that have worked and may be 

useful: 

-To format the picture in the cell, go to Format, scroll 

down to Object 

-Choose Layout, then choose Wrapping Style: Square 

-Choose the Horizontal alignment: Right 

-Click OK 

12. Save your document a few times while you are 



placing the slides so you don’t lose all your work if 

the program crashes.  

13. Also, please remember to make note of any slides 

that have special animation. 

 

 


